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Purpose

o Provide an overview of the CORE security
o Demonstrate automated workflow
o Answer your questions
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Agenda

o CORE ERP

o Security Framework

o Workflow Lifecycle

o Workflow Demonstration
o Wrap-up

o Questions & Answers
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Security Framework

o Security governs everything a person can see and do
in the system
o Security Role

o Explicit access to certain tables, documents, and queries
by functional area

o User Profile
o The sum of a user’s security roles

ANY Role

User Security Profile
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Workflow Definition

Workflow automation is a defined set of rules
required to accomplish a specific goal; the
software is able to automatically route tasks
through the process to each subsequent step,
all the way to the completion of that goal.

idatix.com
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Key Benefits of Workflow

o Increases Efficiencies
o Establishes a Defined Repeatable Process
o Promotes Internal Controls
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General Workflow Lifecycle

DRAFT

PENDING

Reject

Create
Document —Submit Yes

Approval 1

FINAL

—Approver-

No

Approval 2
(Final)
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Workflow Basics

o Workflow - Automatic routing of documents for approval
o Routing is based on document and department code
o Cannot approve your own document

o Cannot apply your approval more than once to single
document

o Documents are locked down during the approval process
o Once approved - Updates journals in real-time

o Visibility - Where it is and how long it takes

o No “In-Transit Time” - All electronic, faster than paper
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User ID:

Password:
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Reset |

Copyright © 2001, 2012 CGI Technologies and Solutions
Inc. All Rights Reserved.

Use of this software is subject fo CGI Technologies and
Solutions Inc. license agreement.

AMS Advantage® is a registered trademark of CGl
Technologies and Solutions Inc

Add AMS Advantage to your Favorites
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Document Name: |JV -Orig Req 0224 A Budget Control Level Reduction: [
Fund Balance Control Level Reduction: |
Record Date: B

Cash Balance Control Level Reduction: [
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b Reversal Date:

Fiscal Year:
Create Reversal Document on Hold: [~

Period:

Document Description: -

Total Credits: 30.00

Total Debits: $0.00
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Header ——
Line Group Total Lines: 1 Line Group: 1 Event Type: GAOS  Vendor Customer:
Accounting Line Posting Code Posting Code Name Debit Amount
1 A0 Cash
2 ROO3 External Collected Earned Revenue

From 1 to 2 Total 2

G Gl Reference | Fund Accounting || Detail Accounting

Event Type: GADS Budget FY: l:l
Posting Pair: A Fiscal Year: |:|
Posting Pair Hame: A Period: l:l
Posting Code: Bank: -
Posting Code Name: External Cellected Earned Revenue

Line Description: -

Debit Amount: | 50.00
Credit Amount: | 100.00

Ed Submit

H save i || iy et mns s [ g s g s | e Edit with d—|
Posting \ / Total Lines: 1 Posting Line: 1
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Accounting Line Posting Code Posting Code Name Debit Ami
1 Al Cash
2 RO03 External Collected Earned Revenue
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Gl Reference | Fund Accounting || Detail Accounting

Event Type: GADS Budget FY:

Posting Pair: A Fiscal Year:

Posting Pair Name: A Period:
Posting Code:  ap E‘ Bank: g E‘
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Accounting Template: E‘
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Message Center
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Search
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History

Favorites

e

Administration
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infoAdvantage

Track Work in Progress - JV1STHD - ACAA - 20140000000000000014 - 1

Date Submitted : 2/24/2014 Submitter : Jonny Entry

Approval Rule ID Seq No Approval Level Assignment Date Initial Assignee Name Approval Status  Approval User Name
+ T3 1 1 2014-02-24 GA ApprovakACAA Pending

& View | og

/Trnclc Work in Progress - JV1STND - ACAA - 20140000000000000014 - 1
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v T3

o

Date Submitted : 2/24/2014 Submitter : Jonny Entry

1 1 2014-02-24 GA Approval-ACAA Pending

™ View Log

Approval Rule ID SeqNo Approval Level Assignment Date Initial Assignee Name Approval Status Approval User Name
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Workflow

-

System validation

DRAFT
User submits document User enters document

Approval workflow initiated
PENDING

Functional Approval Group
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User rejects document
and adds comments

Workflow
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User applies Policies &
Procedure to Approve or Reject

Document is routed back to
initiator’s queue
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Submitter ID :

Browse Clear

Level Code Dept 10 Comments Creator D Submitter ID Date Reason Message
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Standard Journal \fnucher{.l\f'lsﬂll]}| Dept: ACAA  ID: 20140000000000000014  Ver: 1 Function: New  Phase: Pending |E|

I nELO | Exdended Description | Contact | Document Information

Document Name: | _Orig Req 0224 - Budget Control Level Reduction: [~
. Fund Balance Control Level Reduction: [~
Record Date: Cash Balance Control Level Reduction: [~
Euuget il Reversal Date:
Fiscal Year: Create Reversal Document on Hold: [~
Period:
i Document Description: -
l Total Credits: $100.00
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Document ID :

Version :
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documentation
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*Comment : plegze attach supporting
documentation.
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Workflow

System validation
DRAFT

User resubmits document User modifies document

Approval workflow initiated

PENDING Functional Approval Group
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Worklist Code : ﬁ
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Search D=
History Submitter 1D :
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Administration
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infoAdvantage Level Code Dept 1D Comments Creator ID Submitter ID Date Reason Message
|:| 1 JVISTND ACAA 20140000000000000014 Yes jentry jentry 212412014 5:27:31 PN Apply approval A document has been routed to your approval queue.
First Prew Next Last Approve Reject Take Task Return Task Refresh
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140000000000000014 Ver.: 1 Function: New Phase: Pending |E| Modified by jentry , 02/24/2014

D:

ene cxenuea vescnpuen || Coggfict || Document Information
oy .
@ Document Name: | _Orig Req 0224 - Budget Control Level Reduction: [~

Fund Balance Cantrol Level Reduction:

-

Record Date: Cash Balance Control Level Reduction: [~
Budget FY: Reversal Date:
Fiscal Year: Create Reversal Document on Hold: [~
Period:
Document Description: -

Total Credits: 5100.00

Total Debits: $100.00

||
4
Line Group Total Lines: 1 Line Group: 1 Event Type: GAOS Vendor Ci
Accounting Total Lines: 2 Accounting Line: 1  Posting Code: A001  Posting Code Hame: Cash
Posting Total Lines: 1  Posting Line: 1
|(h copy| |Gt Discars| | @ Approve || Gy Reject |
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Message Center
Inbox
Alerts

Broadcasts

ts for Hi

I
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Forms
Search
History
Favorites
Administration

infoAdvantage

Component Context File Name Date UserID Primary State

v JV_DOC_HDR HEADER Memorandum.docx 2/24/14 jentry New
First Prev Next Last

Return to Document

Memorandum

To: Bob Controller

cc: S Approver
From: Jonny Entry
Date:  2/24/2014

Re: v

Journal Voucher

Select text you would like to replace, and type yourmemo. Use styles suchas Heading 1-3 and Body
Textin the Style control on the Formatting toolbar.

To delete the background elements—such as the cirele, rectangles. or return address frames, click on
the boundary borderto highlight the “handles.” and press Delete. Some of the objects are part ofa
background watermark. so you have to choose Header and Footer from the View menu in order to
select them. To replace the picture in this template with a different one, first click on the picture.
Then, on the Insert menu, point to Picture, and click From File. Locate the folder that contains the
picture you want to insert, then double-click the picture.

To save changes to this template for future use, choose Save As from the File menu. In the Save As.
Type box, choose Document Template. Nexttime you want to use it, choose New from the File
menu, and then double-click your template.
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Document Name: | _Orig Req 0224 - Budget Control Level Reduction: [~
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-
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Period:
Document Description: -
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Document Name: | _Orig Req 0224 - Budget Control Level Reduction: [~

Fund Balance Cantrol Level Reduction:
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Record Date: (2/24/2014

Budget FY: 2014

Cash Balance Control Level Reduction: [~

Reversal Date:
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Document Description: -

Total Credits: 5100.00
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Line Group Total Lines: 1 Line Group: 1  Event Type: GAOS  Vendor C
Accounting Total Lines: 2 Accounting Line: 1 Posting Code: 4001 Posting Code Hame: Cash
Posting Total Lines: 1 Posting Line: 1
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Workflow
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User applies Policies & Procedure PENDING
to Approve or Reject

Functional Approval Group

User approves document
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Final, journals updated

CORE

&.M Colorado Operations Resource Engine

EMPOWERING EFFICIENCY

Confidential and Proprietary material of Colorado and CGlI.
Documents contain material for Colorado’s internal use only




© AMS Advantage - Windows Internet Explorer“ — e .‘a ‘

| ‘@ https://codpa-npd.hostams.com:1443/webapp/DE1FIN1J1/Advantage;jsessionid=0000J-t1unTVtTmCVZaed5RU8TI:-1

Il |

WA M Advantage ump to:

Welcome, Sally Approver Procurement Budgeting Accounts Receivable Accounts Payable
[E] Message Center Track Work in Progress - JV1STND - ACAA - 20140000000000000014 - 1
Inbox
Alerts < 5
Date Submitted : 2/24/2014 Submitter : Jonny Entry
Broadcasts
Worklist Approval Rule ID Seq No Approval Level Assignment Date Initial Assignee Name Approval Status Approval User Name
o 73 1 1 2014-02-24 GA Approval-ACAA Approved Sally Approver
# View Log
Search
Hijgfory
Gff Fav
aa Track Work in Progress - JV1STND - ACAA - 20140000000000000014 - 1

inf¢
Date Submitted : 2/24/2014 Submitter : Jonny Entry

Approval Rule ID Seq No Approval Level Assignment Date Initial Assignee Name Approval Status Approval User Name
73 1 1 2014-02-24 GA Approval-ACAA Approved Sally Approver

‘ * View Log
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Wrap-up

o Security
= More robust
= Standardize approach
* Transparent

o Workflow

» Increased efficiencies

= Stronger internal controls

= Defined, repeatable process
= Improved visibility
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A Few Reminders

 Test Drive CORE - Room 602

* Training Starts in April
o Registration instructions emailed to all
o Register promptly for best selection of times and locations
o Send training questions to: core.training@state.co.us

« At end of conference, fill out the CORE Conference
evaluation
o In your packet
o Turn it in to any Conference Ambassador in a green shirt

CORE

Colorado Operations Resource Engine

A

EMPOWERING EFFICIENCY

Confidential and Proprietary material of Colorado and CGlI.
Documents contain material for Colorado’s internal use only




Stay in Touch with CORE

« Read your emails from CORE.news & CORE.training

* Send questions or comments to CORE.news@state.co.us

 Request access to CORE Project website
by sending email to CORE.news@state.co.us

* Talk to your department leaders and CORE functional
experts

« Share what you know with others on your teams
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